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Copyright Notice

This PRODUCT is owned by 1429307 Ontario Ltd. and is protected under copyright laws and
international copyright treaties as well as other intellectual property laws and treaties. This
PRODUCT is licensed, not sold. This software is provided under the license (included as a
separate document), which defines what you may do with the PRODUCT, and contains
limitations on warranties and/or remedies.

For complete information, please read the license agreement that came with Versioneer. The
license contains important information about how you may use the PRODUCT and your rights.

IMPORTANT — carefully read the license before using this PRODUCT. The
LICENCE AGREEMENT is a legal agreement between you (either an individual
or a single entity) and 1429307 Ontario Ltd. for the PRODUCT identified above,
which includes computer software and may include associated media, printed
materials, and "online" or electronic documentation ("PRODUCT"). Installing,
copying, or otherwise using the PRODUCT, indicates your acknowledgement that
you have read the license and agree to its terms. If you do not agree to the terms
of the agreement, do not install or use the PRODUCT; you may, however, return
it to your place of purchase for a full refund to: Customer Service 1429307
Ontario Ltd., 128 Heathwood Heights Drive, Aurora, ON L4G 4W1, Canada
within 10 days of the date you acquired it for a full refund.
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THANK YOU

Thank you for your recent purchase of Versioneer. Managing versions of documents
produced has never been more important. In large projects it is a critical component of
change control and document management. With Versioneer, you can readily organize the
naming and storage of documents that move through approval processes. As a result, you
bring quality and consistency to the handling of your documents, which translates into
improved document control.

Versioneer is implemented using Microsoft Word global templates and Excel and
PowerPoint Add-Ins, so no new macros are introduced to your documents. Since the macros
are held outside the document, there is no possibility that a document cannot be e-mailed
because of mail system virus checking.

FILE NAMING

With Versioneer, you can readily identify the version of any Microsoft Word, Excel and
PowerPoint documents. Documents are easily named according to their release status. For
example “Versioneer SPD V1.2-3” might identify that the first major version of the
document has been released. The

number two indicates that the [IFRFTFPERRTRERHTEAEN EET 2| x]
document has been updated for -
review two times. The number
three shows that there have been Name: | |
three editing changes to the Checked by

document during review. Client :‘

Date completed

General ] Surnrnary ] Skakiskics ] Contents  Custam l

Department

DOCUMENT PROPERTIES D, .
Versioneer updates two Type: [Text -]
document properties (if they
exist) each time it saves the & | ™ Link to content
document. Ver_swneer stores the Properties: [Tyame el Tope
document version number and version 01 Test
the date the document was saved Date complsted 1/20/2001 Date
in document properties. These Disposition Draft Text
properties can then be used in a Department Custamer Support Text
document management system, Shatus Released Teut

or as fields in your work.

The “Date completed” is set to
the current date. The value of the
“Version” property is taken from
the filename.




RECORD OF CHANGES

Versioneer searches documents for a table containing a Record of Changes. A row is added
to the table each time a new Major or Minor version is saved. Versioneer also asks for a
description to enter into the record as well. If a new edit version is saved, Versioneer just
updates the Revision number and issue date.

RECORD OF CHANGES

Revision Description Issue Date
1.1-2 Original working release September 10, 2000
1.2-2 Incorporates changes from review. September 16, 2000
2.0-1 Public Release October 3, 2000

SPECIAL FEATURES

Versioneer treats each document type in a special way. This is fully described later. In
Word documents, Versioneer looks for fields in the document and updates them. In Excel,
Versioneer looks for a separate worksheet that holds the record of changes. In PowerPoint
and Excel, Versioneer checks the document headers and footers for either the version
number or the full filename and updates them with the new name or version.

NEwW FEATURES

Version 1.3 of Versioneer improved the order questions were asked for determining the
release number of a document. The order was changed from Major, Minor then Edit to Edit,
Minor then Major to match more closely with the types of changes that are made to
documents. This version also included better checking to determine if a document
conformed to Versioneer naming standard.

Version 1.4 introduces the ability to omit the Edit number in a document name. Documents
can now end with Vm.n and Versioneer will happily update the version information.

Version 1.5 updates the headers and footers of Excel in addition to PowerPoint. Headers
and footers are checked for the version number only. In this way, any text can be included
in these areas. Support for Macintosh is included.

Version 1.6 accepts many more titles for the Record of Changes.

Version 1.7 includes even more title choices for the Record of changes and accepts a variety
of separators between the file name and version number. A move to a major or minor
version now sets the edit number to zero, meaning that no changes have been made. This
version can also add version control to a document while saving it for the first time.




INSTALLING VERSIONEER

Five files make up the Versioneer product, one for each of Microsoft Word, Excel, two for
PowerPoint and an Installation Helper that uses an Excel macro. There are separate versions
of the PowerPoint Add-In for Office 97 and Office 2000.

E4 Microsoft Excel - Installation Helper. xls i =] ﬂ

File Edit “iew Inzett Format Tools Data Window Help

DEEHS GAY $BBR T o- Q= A2 BSE 7% Pon? BE - 2
I =

This software product is owned by 1429307 Ontario Ltd. and is protected under copyright
laws and international copyright treaties as well as other intellectual property laws and
treaties. This software product is licensed, not sold. This software is provided under license,
which defines what you may do with the product, and contains limitations on warranties
and/or remedies.

The Installation Helper will copy Yersioneer fram and to these locations.
From ChDocurments and Settings\serhy Documents\Wersioneer 9.0
To ChDocuments and Settings\UserApplication DatatMicrosoftidding FowerF oint
ChADocuments and Settings\UsertApplication DatatbicrosoftWord STARTUR Word
ChADocuments and Settings\UserApplication Datatbicrosoftdddins Excel

I've read the copyright
notice and am ready to
install Wersionesr.

| do not want to install
“ersionger,

Ready F-LIM

To start the installation process, open the Installation Helper spreadsheet, and if asked,
enable macros. If you do not accept the licence terms and choose not to install Versioneer,
click the button on the right. The Installation Helper will close, and you can return
Versioneer for a refund.

After having read the copyright notice, click on the button on the left hand side of the
Versioneer logo to proceed with the installation. The Installation Helper will copy the
correct files to the correct locations for the version of Microsoft office you are using.




Ed Microsoft Excel - Installation Helper_xls =0 x|
File Edit “iew |nzett Format Toolz Data “Window Help
DEE SR @ £ @ 7% [Pom?| -2
= =

Installation of Yersioneer is complete except for some final steps you must complete.

Word Installation for Word is complete. Mext time you stat Word, the
Yerzsioneer toolbar will be available.
Excel The Addin for Excel iz in the Addins directary. To complete the

installation select Addlns... from the Tools menu, and select the
“ersioneer Addin by checking the box and clicking Ok, The
“ersioneer toalbar will appear.

PowerPoint The Addln for PowerFaint is in the Addins directory
(C:\Documents and Settingsiderrickd\Application
DatatMicrosoftdddins) . From the Tools menu, select Addins. .
and select the Yersioneer Addln by clicking on the macro name
and then the load button. The Yersioneer toolbar will appear.

Thankyou for choosing
“ersioneer,

Ready LI

After the Installation Helper moves the Add-Ins and templates to the correct location, a final
screen is displayed that identifies the tasks that must be completed manually.

Word. No further steps are required to install the Versioneer global template. Word
accesses the template each time it starts. To prevent the template from loading, it must
be moved from the directory shown.

Excel. The Excel Add-In is not automatically loaded after installation or when Excel is
started. Follow the instructions to load Versioneer and make the Add-In available while
you work with Excel. Once the Add-In is loaded, it will be available each time Excel
starts until it is explicitly unloaded.

PowerPoint. As with Excel, the PowerPoint Add-In is not automatically loaded after
installation. With PowerPoint 97, you must locate the Add-In in the directory shown.
With PowerPoint 2000, the correct directory will be located when the load function is
selected.




'USING VERSIONEER

Using Versioneer is as easy as clicking on a toolbar button. When you click on the
El Versioneer button, you will be asked a series of questions that determine the new
version number and so the new filename that your document will be saved with.

If the file has never been saved |EEFEETRTE————rm x|
with Versioneer, or does not have -

the correct format for the version & This document does not Follow Ehe naming convention used

. by the Wersioneer Produck, Do waou wank ko add this support
number in the filename, the first by adding to the Fil name?
matter that must be dealt with is
whether or not to add the version
number to the file name. If No is
selected, then Versioneer returns to the document without saving it. Selecting Yes lets
Versioneer know that it can ask the rest of the questions necessary to determine how to
name the file for the first time. The version number will be one of V0.0-1, V0.1-1 or V1.0-1.

Save With Yersion Control X|| 1If the version can be appended to the
The old wersion of the document is at revision level ﬁlen‘ame’ or if the filename has. the
Major Yersion 1 version number at the end and it is
pinor Yerson 2 formatted correctly, then Versioneer
checks if the version number should
Do wou wank ko save with a new wersion number? be updated.

o Cancel Three options are presented. If
Cancel is selected, Versioneer returns
to the document without saving it. Choosing No tells Versioneer to just save the file with
the same filename that it currently has. Choosing Yes tells Versioneer to check how the
version number should be incremented.

The first choice offered is to save the file with a
new edit number. This increases the right most
number by one.. If you answer yes, Versioneer @ I this & ew Edit release (v1.2-4) 7
saves the file with a new filename with the new

version number at the end of the filename. If you
answer no, Versioneer goes on to ask about the
minor version number. Versioneer asks about the
edit release first because edit releases tend to happen more often. Edit numbers are optional.
If you have a file already ending in Vm.n, Versioneer will not ask for a new edit number.

Save with Yersion Conktrol El

The minor release works the same way as an edit
release. Choosing Yes tells Versioneer to save the
file with an increased minor version number.
Choosing No tells Versioneer to move to the
Major version. The major version works in the
same way. Major and minor versions also mean
that you may have to answer one extra question.




The last question asked gives you
a chance to add a note about why

the new version of the document = Enter the description for this release:

Save with ¥ersion Conktrol

was created.
Cancel

The description can be up to 255
characters and used to update a
record of changes. With |
PowerPoint 97, Versioneer stores
the description in the Comments property and always asks it. The current document
Comments are displayed and if you change the comments and click OK, the Comments are
updated. Clicking Cancel or leaving the properties as is prevents Versioneer from updating
the comments.

With PowerPoint 2000, Word and Excel, Versioneer uses the description to update a record
of changes located in the document (if it exists). The record of changes is a table with three
columns and headings as shown below. If Versioneer can’t find the table, it won’t ask for

RECORD OF CHANGES

Revision Description Issue Date
1.1-2 Original working release September 10, 2000
1.2-2 Incorporates changes from review. September 16, 2000
2.0-1 Public Release October 3, 2000

the description. When Major and Minor version are saved, Versioneer adds a new row to
hold the change information. With an edit release, Versioneer updates the last row in the
table with the revision (version) number and updates the issue date with the current date on
your computer.

In PowerPoint 2000 and Word, the table can be located anywhere in the document. In
Excel, Versioneer looks for a worksheet with the name record of changes. Versioneer adds
an entry to record of changes regardless of whether OK or Cancel is clicked as long as the
description is not blank.

Save With Yersion Control x|| Versioneer checks to see that it will
' not overwrite a newer version of the
document. If it finds a document

@ & version af the document exists at revision lewvel Wo,0-9

Do you wank bo save with a new version number? with the version number that has
been suggested, it gives you the
o Cancel option of moving to a new version

number higher than the one just
tried. Answering Yes takes you back to the edit number question, No just saves the
document with the original name and version, and Cancel stops the process.

After answering the final question, Versioneer looks for two custom document properties. If
the property “Version” exists, it is updated with the version number that is included in the
filename. If the property “Date completed” exists, it is updated with the date that the file is
saved. The date comes from the clock in your computer.




'SETTING UP YOUR DOCUMENT

Setting up your document for Versioneer can be as involve as little or as much work as you
would like to do. All that is required for Versioneer to help you is the addition of version
information to the filename and Versioneer can help you with that!

Versioneer treats Word, Excel and PowerPoint file types with some common features.

FILENAMES

Versioneer works by adding the version number of the document to the filename. The
version number is in the format V1.2-3. The letter V is the start of the version number.
Versioneer uses the rest of the numbers to help you keep track of which version of the file
has been saved. This is the only piece of information Versioneer needs. When a new
version of your document is saved, Versioneer checks the filename for the old version
number and increments in according to your requirements.

Versioneer will add the version number to the end of the filename automatically. When
Versioneer does this, the format is V1.2-3. When new versions are saved, Versioneer
always asks about Edit, Minor and Major version numbers. Optionally, you can add the
version number before using Versioneer for the first time. When you add the version
number, you can choose between the formats V1.2-3 with edit numbers, and V1.2 without
edit numbers. If the edit number is not in the filename, Versioneer will not add it and will
not ask about edit releases.

While Versioneer adds the single letter V to filenames when adding version numbers, it can
accept a variety of existing separators. The case is not important and the text can have
spaces before or after the separator. Valid separators are V, VER, VERS, and VERSION.

DOCUMENT PROPERTIES

Versioneer checks for two document properties. These properties are maintained as a
convenience and are not used by Versioneer. If the custom property exists, Versioneer
updates it. The property names are not case sensitive.

The first property is “Version”. It stored as text and is updated based on the version number
in the filename. The property can be used in document management systems or simply
displayed inside the document.

The other property Versioneer will update is the “Date Completed”. This value is stored as
a date value. The date stored is the date that Versioneer saves the document and comes from
the computer’s clock. Again, the property is available for your use. Because the date is
stored as a date value, you can format it any way you want in the document.




WORD FEATURES

21 %]
When Versioneer saves the Categaries: Field names:

document, it updates the version and  [ral ALthor -
date completed custom document |Dateand Time Comments

. . . Document Automation DocProperky
properties (lf they eXlSt)' These Diocument Infarmakion FilzMarne

properties can be inserted into your  |[Egquations and Formulas FileSize
Index and Tables Info
document as fields. Links and References Kewwords
. Mail Merge LastSavedBy
To insert a custom field such as |wumbering NumChars
“Version”, select the menu option  IUser Infarmation MumPages [
Insert > Field and then select Eieldcodes:  DOCPROPERTY “Mame"

Documents Information and
DocProperty as the field name. The |[POCPROPERTY

Options button allows you to select  Description

the document property to insert. The Inserts the value of the property chosen in Cptions
field will be of the form
{ DOCPROPERTY "Version" \*
MERGEFORMAT }. “Version” is Options. ..
the property being inserted.

[V Preserve formatting during updates

Cancel

Just before Versioneer saves the document, it updates document fields. Versioneer looks at
all of the fields and checks what type they are before updating them, Versioneer will not
update following field types: Table of Authorities, Table of Contents, Hyperlinks, Page
references, and References.

The fields can be located at any point in the document and are especially useful in headers
and footers.

Versioneer User Documentation Version 1.6-1
May 28, 2001 Page 8
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EXCEL FEATURES F Microsoft Excel - Ercel Sample ¥1.1-1.815 -0 x|
J File Edit Wew Insert Format Tools Data Window Help -|I5’|£|

EAIE 2| -2

When Versioneer saves an
Excel workbook, it looks for |0 & H &[& B« -

a worksheet with the name 9 4
Record of Changes. If the A B | C | o | Ej
worksheet exists and there is
information  formatted as 1 |[Record of Changes
shown in the figure below 2 |Revision |Description Issue Date

. ’ 3011 This is the ariginal 29-Dec-00

fi
:;rvswnfﬁz.;dds 02; ro‘:’ningi 4 (102 |Afer update 29-Dec-00
. . : 5 111 Final “ersion 10-Jan-01
information. You can use 5
|

lnformatlon in the reCQTd Of 44 |> |Hr"'.|REEDI‘d of Changes f Sheetl I F I
changes in other location in f] | | | | |

your workbook.

s
[

Versioneer also check the headers and footers of each sheet in the workbook. If Versioneer
can find the version number, it replaces it with the new version number.

POWERPOINT FEATURES

With PowerPoint,
Versioneer looks in
the Handout Master,
Notes Master, Slide |01 & I | =1 | E| N
Master Title Master
footers and Handout
Master and Notes

Master header for the Record of Changes

document version

numbe‘r. If it is Revision |Description Issue Date
found in any of these 123 Sample Mews YWersion January 16, 2000

locations, Versioneer
updates the header or
footer. Versioneer
then check each slide
in the same way.

PowerPoint 97 does
not directly support
tables. (Tables in Versioneer Sarple 2000 V1.2-3
PowerPoint 97 are
embedded Word |[m=Ea=w ¢ »
objects that hold the J Draw = IE| futoShapes = ™, w () | Sd-A-=B@m ?

‘;albglesl.;CkBeg; usteab(lf | Slide 3 of 3 | Default Design ==

w




support, Versioneer stores the release description in the Comments property on the summary
tab of the document. The current document Comments are displayed and if you change the
comments and click OK, the Comments are updated. Clicking Cancel or leaving the
properties as is will prevent Versioneer from updating the comments. PowerPoint 97 is the
only product that Versioneer updates the comments.

In PowerPoint 2000, tables can be added directly to a slide without having to embed a Word
document. Versioneer takes advantage of this and checks each slide for a table structured to
hold a record of changes. If the table exists, Versioneer updates it as described in the section
on Using Versioneer.

RECORD OF CHANGES

The Record of changes is a table in the document. If the table exists, Versioneer asks for a
description of the change and then updates the table accordingly. The table can have any of
the following headings (which are not case sensitive) in any column order:

RECORD OF CHANGES
Revision Description Issue Date Author
revision description issue date author
revision number comment issued authors
version comments issued on who
version number change updated whom
versions changes updated on contributor
date contributors
date issued
date updated
dates
SAMPLES

Sample files are provided for Word, Excel and two versions for PowerPoint. These
documents contain sample records of changes, headers and footers. You’re free to use any
of these design elements in your own documents.
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